The product described in this book is a licensed product of Teradata, a division of NCR Corporation.

NCR, Teradata and BYNET are registered trademarks of NCR Corporation.
Adaptec and SCSISelect are registered trademarks of Adaptec, Inc.
EMC, PowerPath, SRDF, and Symmetrix are registered trademarks of EMC Corporation.
Engenio is a trademark of Engenio Information Technologies, Inc.
Ethernet is a trademark of Xerox Corporation.
GoldenGate is a trademark of GoldenGate Software, Inc.
Hewlett-Packard and HP are registered trademarks of Hewlett-Packard Company.
IBM, CICS, DB2, MVS, RACE, OS/390, Tivoli, and VM are registered trademarks of International Business Machines Corporation.
Intel, Pentium, and XEON are registered trademarks of Intel Corporation.
KBMS is a registered trademark of Trinics Corporation.
Linux is a registered trademark of Linus Torvalds.
LSI, SYM, and SYMplicity are registered trademarks of LSI Logic Corporation.
Active Directory, Microsoft, Windows, Windows Server, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Novell is a registered trademark of Novell, Inc., in the United States and other countries. SUSE is a trademark of SUSE LINUX Products GmbH, a Novell business.
QLogic and SANbox are registered trademarks of QLogic Corporation.
SAS and SAS/C are registered trademark of SAS Institute Inc.
Sun Microsystems, Sun Java, Solaris, SPARC, and Sun are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. or other countries.
Unicode is a registered trademark of Unicode, Inc.
UNIX is a registered trademark of The Open Group in the US and other countries.
NetVault is a trademark and BakBone is a registered trademark of BakBone Software, Inc.
NetBackup and VERITAS are trademarks of VERITAS Software Corporation.
Other product and company names mentioned herein may be the trademarks of their respective owners.

THE INFORMATION CONTAINED IN THIS DOCUMENT IS PROVIDED ON AN “AS-IS” BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. IN NO EVENT WILL NCR CORPORATION (NCR) BE LIABLE FOR ANY INDIRECT, DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS OR LOST SAVINGS, EVEN IF EXPRESSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

The information contained in this document may contain references or cross references to features, functions, products, or services that are not announced or available in your country. Such references do not imply that NCR intends to announce such features, functions, products, or services in your country. Please consult your local NCR representative for those features, functions, products, or services available in your country.

Information contained in this document may contain technical inaccuracies or typographical errors. Information may be changed or updated without notice. NCR may also make improvements or changes in the products or services described in this information at any time without notice.

To maintain the quality of our products and services, we would like your comments on the accuracy, clarity, organization, and value of this document. Please e-mail: teradata-books@lists.ncr.com

Any comments or materials (collectively referred to as “Feedback”) sent to NCR will be deemed non-confidential. NCR will have no obligation of any kind with respect to Feedback and will be free to use, reproduce, disclose, exhibit, display, transform, create derivative works of and distribute the Feedback and derivative works thereof without limitation on a royalty-free basis. Further, NCR will be free to use any ideas, concepts, know-how or techniques contained in such Feedback for any purpose whatsoever, including developing, manufacturing, or marketing products or services incorporating Feedback.

Copyright © 2002-2006 by NCR Corporation. All Rights Reserved.
Preface

Purpose

This book provides information about Teradata SQL Assistant/Web Edition, which is a Teradata® Tools and Utilities product. Teradata Tools and Utilities is a group of products designed to work with Teradata Database.

Teradata SQL Assistant/Web Edition is a Web-based query tool that enables you to compose a query, submit it to the Teradata Database and view the results from a Web browser. Then you can save the data on your PC for analysis.

Audience

This book is intended for use by:

- Relational database developers and SQL proficient developers who know how to formulate queries for processing on Teradata.
- Other users who interface with the Teradata Database.

Supported Releases

This book supports the following releases:

- Teradata Database V2R6.1
- Teradata Tools and Utilities 8.2
- Teradata SQL Assistant/Web Edition 2.2

Note: See “Table 1: Toolbar Icon Description” on page 10 and look at the Information icon to learn how to verify the Teradata SQL Assistant/Web Edition version number.

To locate detailed supported-release information:

2. Navigate to General Search>Publication Product ID.
3. Enter 3119.
4. Open the version of the Teradata Tools and Utilities ##.##.## Supported Versions spreadsheet associated with this release.

The spreadsheet includes supported Teradata Database versions, platforms, and product release numbers.
Prerequisites

The following prerequisite knowledge is required for this product:

- Computer technology and terminology
- Basic concepts of the Teradata Database
- Teradata SQL
- Connectivity software, such as ODBC
- Windows operating system

Changes to This Book

The following changes were made to this book in support of the current release. Changes are marked with change bars. For a complete list of changes to the product, see the Release Definition associated with this release.

<table>
<thead>
<tr>
<th>Date and Release</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 2006 08.02.00</td>
<td>Updated the clear history feature in the History Table. See “Clearing History Rows” on page 34. Added printer icon to Answer Set, History, and Query windows. See “Printing the History Table” on page 34, “Printing the Answer Set Table” on page 29, and “Printing a Query” on page 24. Updated preface. Updated copyright text insert.</td>
</tr>
<tr>
<td>November 2005 08.01.00</td>
<td>Added procedure for reordering columns in an AnswerSet. See “Reordering Columns in an AnswerSet” on page 28.</td>
</tr>
</tbody>
</table>
Additional Information

Additional information that supports this product and Teradata Tools and Utilities is available at the web sites listed in the table that follows. In the table, mmyx represents the publication date of a manual, where mm is the month, y is the last digit of the year, and x is an internal publication code. Match the mmy of a related publication to the date on the cover of this book. This ensures that the publication selected supports the same release.

<table>
<thead>
<tr>
<th>Date and Release</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>October 2004/08.00.00</td>
<td>This book was reformatted. Updated screen capture in introduction. See “Overview of the SQL Assistant Interface” on page 8. Updated the interface icons and screen captures for the Query pane. See “About the Query Pane” on page 19. Updated the interface icons and screen captures for the History pane. See “History Pane Control Items” on page 32. Updated the interface icons and screen captures for the AnswerSet pane. See “Saving an AnswerSet to a File” on page 28. Updated the Database Explorer tree icons and interface. See “Showing or Hiding the Database Explorer Tree” on page 40. Added information about the Edit History dialog box. See “Using the Edit History Dialog” on page 35. Added new icons to the toolbar. See “Description of Toolbar Icons” on page 10. Added Query Builder functionality. See “Building a Query” on page 25. Added the Options dialog box. See “Using the Options Dialog Box” on page 11.</td>
</tr>
</tbody>
</table>

Additional Information
<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Description</th>
<th>Access to Information</th>
</tr>
</thead>
</table>
| Additional product information | Use the NCR Information Products Publishing Library site to view or download specific manuals that supply related or additional information to this manual. | 1 Go to [http://www.info.ncr.com/](http://www.info.ncr.com/).  
2 Select the **Teradata Data Warehousing** check box.  
3 Do one of the following:  
   - For a list of Teradata Tools and Utilities documents, click **Teradata Tools and Utilities** and then select a release or a specific title.  
   - Select a link to any of the data warehousing publications categories listed.  
Specific books related to Teradata SQL Assistant/Web Edition are as follows:  
   - *Teradata Manager User Guide*  
     B035-2428-**mmyx**  
   - ODBC Driver for Teradata User Guide  
     B035-2509-**mmyx**  
   - *Messages*  
     B035-1096-**mmyx** |
| CD-ROM images | Access a link to a downloadable CD-ROM image of all customer documentation for this release. Customers are authorized to create CD-ROMs for their use from this image. | 1 Go to [http://www.info.ncr.com/](http://www.info.ncr.com/).  
2 Select the **General Search** check box.  
3 In the **Title or Keyword** box, type **CD-ROM**.  
4 Click **Search**. |
| Ordering information for manuals | Use the NCR Information Products Publishing Library site to order printed versions of manuals. | 1 Go to [http://www.info.ncr.com/](http://www.info.ncr.com/).  
2 Select the **How to Order** check box under **Print & CD Publications**.  
3 Follow the ordering instructions. |
| General information about Teradata | The Teradata home page provides links to numerous sources of information about Teradata. Links include:  
   - Executive reports, case studies of customer experiences with Teradata, and thought leadership  
   - Technical information, solutions, and expert advice  
   - Press releases, mentions, and media resources | 1 Go to [Teradata.com](http://www.teradata.com).  
2 Select a link. |
Preface

Purpose
Audience
Supported Releases
Prerequisites
Changes to This Book
Additional Information

Chapter 1: Getting Started

SQL Assistant Overview
  How SQL Assistant Can Help You
  Key Features
  How SQL Assistant Works
Setting Up an ODBC Connection on the Server PC
  Installing a Teradata Database ODBC Driver
  Defining a Data Source
  Setting the Number of Client Connections
Starting SQL Assistant
  Finding the Computer Name or IP Address of Your Server PC
  Connecting to a Teradata Database
Disconnecting and Closing SQL Assistant

Overview of the SQL Assistant Interface
  Browser Menu Bar
  Browser Toolbar
  Browser Address Bar
  Description of Toolbar Icons
  Using the Options Dialog Box
Query Pane
History Pane
AnswerSet Pane
Database Explorer Tree
Status Bar
Changing the Database Password
Chapter 2: Using the Query Pane

About the Query Pane ..................................................19
    Before You Begin ...............................................19
    Aborting Queries ..............................................20
How to Use the Query Pane .......................................20
    Entering and Executing a Query. ............................20
    Saving a Query ..............................................21
    Automatically Running a Query from a File ..............21
    Loading a Query from a File Without Running It .......22
    Aborting a Query in Progress ...............................22
    Executing a Query for Large Objects (LOBs) ...........22
    Printing a Query ............................................24
Using Query Builder ..............................................24
    Building a Query ...........................................25
    Inserting a Statement or Procedure into the Query Window ....26

Chapter 3: Using the AnswerSet Pane .........................27

About the AnswerSet Pane .........................................27
How to Use the AnswerSet Pane ..................................27
    Viewing Your Results. ......................................27
    Sorting an AnswerSet ......................................28
    Reordering Columns in an AnswerSet ......................28
    Saving an AnswerSet to a File ..............................28
    Opening a Saved Answerset with Microsoft Excel .....29
    Copying an AnswerSet to the Clipboard ....................29
    Printing the Answer Set Table ..............................29

Chapter 4: Using the History Pane ..............................31

About the History Pane ............................................31
List of Figures

Figure 1: SQL Assistant Architecture .................................................2
Figure 2: The Options Dialog Box.........................................................13
Figure 3: Example of a Query Explanation...........................................16
Figure 4: Query Text Box Shortcut Menu ............................................16
Figure 5: LOB Dialog Box.................................................................23
Figure 6: AnswerSet Window showing a BLOB AnswerSet .....................24
Figure 7: Query Print Preview Window ..............................................24
Figure 8: Query Builder Window .......................................................25
Figure 9: Answer Set Print Preview Window .......................................30
Figure 10: Print History Window .......................................................35
Figure 11: Edit History Dialog Box ....................................................36
List of Figures
List of Tables

Table 1: Toolbar Icon Description .................................................. 10
Table 2: Description of the Option Dialog ......................................... 11
Table 3: Query Text Box Shortcut Menu Commands and Descriptions ........ 17
Table 4: Microsoft Internet Explorer Commands and Shortcut Keys ............ 17
Table 5: LOB Dialog Box Field Descriptions ....................................... 23
Table 6: Query Builder Options ....................................................... 25
Table 7: History Pane Column Descriptions ....................................... 32
Table 8: Edit History Dialog Field Descriptions ................................... 36
Table 9: Solutions to Error Codes in the History Table ............................ 43
Table 10: Solutions to Browser Messages and Errors .............................. 44
List of Tables
CHAPTER 1 Getting Started

In this chapter, you will learn information you need before using SQL Assistant. This chapter contains the following information:

- SQL Assistant Overview
- Setting Up an ODBC Connection on the Server PC
- Starting SQL Assistant
- Disconnecting and Closing SQL Assistant
- Overview of the SQL Assistant Interface
- Printing

Note: In this user guide, Teradata SQL Assistant/Web Edition is called SQL Assistant.

SQL Assistant Overview

In this overview, you learn about SQL Assistant, its features, and how it works.

How SQL Assistant Can Help You

SQL Assistant is a Web-based query tool that enables you to compose a query, submit it to the Teradata Database, view the results from a Web browser, and save the data on your PC for analysis.

Using SQL Assistant, you can save the data retrieved from Teradata Databases to create consolidated reports or to analyze the data. SQL Assistant gives you SQL activity, complete with source identification, timings, row counts, and your notes. This is useful because you can use the historical record to build SQL scripts and then modify the scripts to gather more specific results.

Key Features

Using SQL Assistant, you can:

- Send queries to any Teradata Database.
- View and sort the results by column and save them to a file.
- Save queries to a file so you can run them automatically from the same file in the future.
- Load queries from a file and make changes before submitting them to the database.
- View historical records of the queries you have submitted with timings and status information. You can sort the history rows by column, update them with your notes, and save the records to a file.
View a hierarchical listing of databases with object names to reduce the time required to create SQL statements.

Use the browser’s built-in find features to do a string search on a query, an AnswerSet, or any information in the historical table visible in the browser window.

Abort a query in progress if you change your mind about running a query or if a query is taking longer than you expected.

Also, to maintain security and help maximize your server’s resources, your browser’s connection ends after 30 minutes of inactivity.

How SQL Assistant Works

SQL Assistant uses a Web browser to interface to the Teradata Database. This design lets you connect several client PCs to one server PC where the application and its associated connectivity software is installed. Client PCs require Microsoft Internet Explorer 5.5 or later or Netscape 7 or later to access the Teradata Database.

<table>
<thead>
<tr>
<th>If you use…</th>
<th>Install…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer 5.5</td>
<td>IE 5.5 Service Pack 2</td>
</tr>
<tr>
<td>Microsoft Internet Explorer 6.0</td>
<td>IE 6.0 Service Pack 1</td>
</tr>
</tbody>
</table>

![Figure 1: SQL Assistant Architecture](image)

Server PC

After installing SQL Assistant and the connectivity software on the server PC, you can send queries to the Teradata Database. The database retrieves the data and returns the results back to your server PC.
Chapter 1: Getting Started

Setting Up an ODBC Connection on the Server PC

<table>
<thead>
<tr>
<th>Install...</th>
<th>if you want...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000 Professional, XP</td>
<td>less than 10 client PC connections.</td>
</tr>
<tr>
<td>Windows 2000 Server</td>
<td>more than 10 client PC connections.</td>
</tr>
<tr>
<td>Windows Server 2003</td>
<td>more than 10 connections.</td>
</tr>
</tbody>
</table>

If you installed a Windows Server OS and want to change the number of client PC connections, see “Setting the Number of Client Connections” on page 4 or Teradata Tools and Utilities Installation Guide for Microsoft Windows.

Client PCs

If you are a client PC user running any Windows operating system, you need to have only a Microsoft Internet Explorer Web browser (version 5.50 or later) or Netscape 7 (or later) installed. As long as your server PC has an active connection to the Teradata Database, your client PC can send queries to the database.

Teradata Database

You can send queries to any database as long as your DBA has set access permissions.

Setting Up an ODBC Connection on the Server PC

Before you use SQL Assistant on a server PC, you must install a Teradata Database Open Database Connectivity (ODBC) driver. The driver lets you connect to a Teradata Database from SQL Assistant.

After installing the driver, you must also define a data source on the server PC for each Teradata Database you want to use before you can access the data in the Teradata Database.

If you need additional information on setting up an ODBC connection, refer to ODBC Driver for Teradata User Guide. See “Additional Information” on page v.

Installing a Teradata Database ODBC Driver

The Teradata Database ODBC driver is designed specifically for the Teradata Database system. You can obtain the driver from your Teradata Database vendor.

Client PCs do not need to install an ODBC driver. Only server PCs must install the ODBC driver.

For information on installing a Teradata Database ODBC driver, refer to Teradata Tools and Utilities Installation Guide for Microsoft Windows.
Defining a Data Source

After you install a Teradata Database ODBC driver on your server PC, you need to define a data source for each Teradata Database.

You use the ODBC Data Source Administrator to configure some features of the drivers installed on your system.

You also use the ODBC Data Source Administrator to create ODBC data sources.

Types of Data Sources

There are two types of data sources: File DSN and System DSN.

You can connect to only one data source at a time, however, you can define as many as you like.

To Define a Data Source

1. Open the ODBC Data Source Administrator by clicking Start > Programs > OBDC > 32-bit ODBC Administrator.

2. In the ODBC Data Source Administrator dialog box, choose a DSN.
   - From the User DSN tab, click Add.
   - Or, from the System DSN tab, click Add.

3. In the Create New Data Source dialog box, select Teradata as the driver for which you want to set up a data source from the Name column.

4. Click Finish. The ODBC Driver Setup dialog box opens. This dialog box is specific to the Teradata Database.

5. Complete the fields in the ODBC Driver Setup dialog.

6. When finished, click OK to close the ODBC Driver Setup dialog box and return to the ODBC Data Source Administrator.

7. Click OK to close the ODBC Data Source Administrator and return to your Windows desktop.

Note for System Administrator: If you will have any client PCs access your server PC, we recommend you leave the Default Database, Username, Password, and Account String fields blank. However, if you plan to set up different DSNs for each category of user, you can enter a default database and account string at this time.

Setting the Number of Client Connections

If you have Windows Server OS installed, you can adjust the number of client PCs that connect to your server PC. Typically, this is done by your system administrator.
To Change the Connections Setting

1. Click the Start button. Next, go to Settings, then Control Panel, then Administrative Tools, and click Internet Services Manager.
2. In the left panel, click the plus sign (+) next to your computer name to expand the tree.
4. From the Web Site tab, choose one of the following options:

<table>
<thead>
<tr>
<th>Select This Option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlimited</td>
<td>Allow an unlimited number of connections to occur simultaneously.</td>
</tr>
<tr>
<td>Limited to &lt;number&gt; connections</td>
<td>Limit the maximum number of simultaneous connections to the site.</td>
</tr>
</tbody>
</table>

5. Click Apply.
6. Click OK to close the Default Web Site Properties dialog box.

Starting SQL Assistant

To Start SQL Assistant

1. Find the computer name of the server.
   Or, the IP address of the server PC.
2. Connect to a database through a browser which starts SQL Assistant.
   If you already know the computer name or IP address of your server PC, you can connect to a Teradata Database. See “To Connect to a Teradata Database” on page 6.

Finding the Computer Name or IP Address of Your Server PC

To Determine the Computer Name of Your Server PC

1. On your desktop, right-click the My Computer icon.
2. From the menu, select Properties.
3. Click the Network Identification tab. The computer name is the Full computer name shown.
To Determine the Server PCs IP Address

1. Click the **Start** button. Next, go to **Programs**, select **Accessories**, and then click **Command Prompt**.

2. At the prompt, type the following:
   
   ```
ping <computer name>
   ```
   
   The four groups of numbers, each separated by a period is the IP address. For example, 153.64.138.72.

3. Write down the number.

4. At the prompt, type `exit`. This will close the **Command Prompt** window.

Now you are ready to connect to the Teradata Database.

**Connecting to a Teradata Database**

To Connect to a Teradata Database

1. Open a Microsoft Internet Explorer browser.

2. In the Address bar, enter a URL that includes the same name of the directory where you installed SQL Assistant.

   In the following example, the user installed SQL Assistant on a server PC in the default location, a virtual directory name called SQLAssistantWeb.

<table>
<thead>
<tr>
<th>If your PC is the...</th>
<th>Enter the following URL:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td><code>http://localhost/SQLAssistantWeb2.1</code></td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td><code>http://&lt;server’s computer name or IP address&gt;/SQLAssistantWeb</code></td>
</tr>
<tr>
<td>Client</td>
<td><code>http://&lt;server’s computer name or IP address&gt;/SQLAssistantWeb</code></td>
</tr>
</tbody>
</table>

3. You can save this URL for quick access in the future. In the Microsoft Internet Explorer browser, from the **Favorites** menu, click **Add to Favorites**.

4. Choose a database by clicking a database name in the **DSN** column.
Starting SQL Assistant

5 The DBC Name or Address text box is filled in automatically. Enter a Username and Password to connect to the Teradata Database.

<table>
<thead>
<tr>
<th>DSN</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qforce</td>
<td>Teradata Machine</td>
</tr>
<tr>
<td>savak</td>
<td></td>
</tr>
<tr>
<td>agassi</td>
<td></td>
</tr>
<tr>
<td>Savak2</td>
<td></td>
</tr>
<tr>
<td>Troy Server</td>
<td></td>
</tr>
</tbody>
</table>

6 (Optional) In the Default Database box, enter the default database you want to use with this logon.

All tables, views, and macros are assumed to be in this default database unless they are explicitly prefixed by a database name in the query.

7 (Optional) In the Account String box, enter any additional logon parameters that define your user group.

8 Click OK.

Note: Existing browser encryption is used to prevent your username and password from being compromised.

You know the connection is complete when the SQL Assistant main Web page appears with a blank Query text box, a History pane, and an AnswerSet pane at the bottom.
Disconnected and Closing SQL Assistant

Your session does not expire or end when you close your browser. You must use the Disconnect button to end your session. Also, your session does not expire if your browser becomes unresponsive.

To Close SQL Assistant

1. In your browser, click **Disconnect Button** located on the **Tool** bar. After disconnecting, you can connect to another database if desired, or simply close your browser window.

2. To close Microsoft Internet Explorer, from the **File** menu, choose **Close**.

Overview of the SQL Assistant Interface

The SQL Assistant main Web page is divided into several panes: a Query pane, a History pane, and an AnswerSet pane. The Database Explorer Tree is an optional pane on the left side.

Click the blue links around the following illustration to read more about a particular key area.
Chapter 1: Getting Started
Overview of the SQL Assistant Interface

Browser Menu Bar

The menu bar in the browser runs along the top of the browser window. You can use the menu bar to access features specific to your browser.

In Microsoft Internet Explorer, the menus are File, Edit, View, Favorites, Tools, and Help.

Note: The Help menu is for the browser, not for SQL Assistant. You can find the Help for the application in the Action and Information Bar, to the far right.

Find Feature

Use the built-in find feature in your browser to do a string search on a query, an AnswerSet, or any information in the history visible in the browser window. From the Edit menu, choose Find (on This Page).

Browser Toolbar

You can use the toolbar to access features specific to your browser. In Microsoft Internet Explorer, the buttons are Back, Forward, Stop, Refresh, Home, Search, Favorites, History, Size, and Print.
Chapter 1: Getting Started
Overview of the SQL Assistant Interface

**Browser Address Bar**

You use the browser’s address bar to enter a URL to choose a data source.

For more information, see “Starting SQL Assistant” on page 5.

**Description of Toolbar Icons**

The Toolbar has a set of icons that allow you to control various functions of Teradata SQL Assistant.

![ Toolbar Icons ]

Table 1 explains the function of each icon.

<table>
<thead>
<tr>
<th>Icon Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="icon" /></td>
<td>This icon disconnects SQL Assistant from the database and returns you to the logon screen. See “Disconnecting and Closing SQL Assistant” on page 8 for more information.</td>
</tr>
<tr>
<td><img src="image2" alt="icon" /></td>
<td>This icon opens a browse dialog box that allows you to browse for saved queries.</td>
</tr>
<tr>
<td><img src="image3" alt="icon" /></td>
<td>This icon submits the query in the Query pane to the database.</td>
</tr>
<tr>
<td><img src="image4" alt="icon" /></td>
<td>Click this icon to get an explanation of the query entered in the Query pane. The explanations shows the steps a query goes through. For more information, see “Using the Explain Query Feature” on page 16.</td>
</tr>
<tr>
<td><img src="image5" alt="icon" /></td>
<td>This icon stops the currently running query.</td>
</tr>
<tr>
<td><img src="image6" alt="icon" /></td>
<td>Enter the maximum number of rows you want the query to return. If the query returns more rows than the maximum limit, a message appears showing the number of rows that do not appear.</td>
</tr>
<tr>
<td><img src="image7" alt="icon" /></td>
<td>This icon displays and hides the Database Explorer Tree. For more information, see “Showing or Hiding the Database Explorer Tree” on page 40.</td>
</tr>
<tr>
<td><img src="image8" alt="icon" /></td>
<td>This icon opens the Query Builder dialog to help you build queries. For more information, see “Using Query Builder” on page 24.</td>
</tr>
<tr>
<td><img src="image9" alt="icon" /></td>
<td>This icon allows you to change the database password. See “Changing the Database Password” on page 15 for more information.</td>
</tr>
<tr>
<td><img src="image10" alt="icon" /></td>
<td>This icon opens the Options dialog. For more information on the Option dialog, see “Using the Options Dialog Box” on page 11.</td>
</tr>
<tr>
<td><img src="image11" alt="icon" /></td>
<td>This field shows the data source and user name SQL Assistant is logged currently logged on to.</td>
</tr>
</tbody>
</table>
Using the Options Dialog Box

The Options dialog box allows you to set various features for Teradata SQL Assistant for the Web.

To Open the Options Dialog

1. Click the Options Dialog box icon. The options dialog box opens.
2. Use the tabs to navigate. Enter changes for each area. Table 2 explains the options available on each tab.
3. After setting your options, click OK to save the changes.

Table 2 shows the options that can be changed. Figure 2 shows an example of the Options dialog box.

Table 2: Description of the Option Dialog

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Query Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Prompt for a note before running any query options</td>
<td>Select this option if you want to add a note before running a query. When you run a query, you will be prompted with a Query Note dialog. Fill in the note as desired, then click OK. The query continues. The default for this setting is unchecked.</td>
</tr>
<tr>
<td>Stop query execution if an SQL error occurs</td>
<td>Stops a query execution if an error occurs. Applies to queries containing multiple statements. If unchecked, Teradata SQL Assistant continues to process statements that follow the statement that generated the error. The default for this setting is checked.</td>
</tr>
<tr>
<td><strong>AnswerSet Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Close AnswerSet tabs before submitting a new query</td>
<td>This option closes the answerset tabs before running a new query. The default for this setting is checked.</td>
</tr>
</tbody>
</table>
Table 2: Description of the Option Dialog  (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display grid lines in AnswerSets</td>
<td>This option displays grid lines between the AnswerSet cells. The default for this setting is checked.</td>
</tr>
<tr>
<td>Shade alternate rows in AnswerSets</td>
<td>This option applies shading to alternate rows in the AnswerSet for easier reading. The default for this setting is checked.</td>
</tr>
<tr>
<td>Display 1000 separators in numeric columns</td>
<td>This option displays the comma in numbers greater than 1000. For example, 1,000. The default for this setting is unchecked.</td>
</tr>
<tr>
<td>Show alert when AnswerSet exceeds maximum rows</td>
<td>This option shows a alert message if the number of rows returned from a query exceeds the maximum row amount set. The default for this setting is checked.</td>
</tr>
<tr>
<td>Max Rows</td>
<td>Enter the maximum number of rows you want SQL Assistant to show per query. If the number of rows returned exceeds this amount, you will be prompted. The default for this setting is ”2000”.</td>
</tr>
<tr>
<td>Display this string for Null data fields</td>
<td>Use this string to represent a null value resulting from a SELECT statement. The default setting for this option is “?”.</td>
</tr>
<tr>
<td>Number of decimal places to display for Float columns</td>
<td>Enter a number between 0 and 9 to define the number of decimal places initially displayed in the AnswerSet grid when the data originated from a column defined as float data type. The default setting is “2”.</td>
</tr>
<tr>
<td>Handle Binary/Byte columns as BLOBs if size &gt;</td>
<td>Enter a number between 0 and 64000. 0 - All Binary/Byte columns will be treated as BLOBs. 64000 - Binary/Byte columns will never be treated as BLOBs. Binary/Byte columns larger than this value will be treated as BLOBs. The default setting for this option is “30”.</td>
</tr>
</tbody>
</table>

**History Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continually update the history table</td>
<td>This option sets the History pane to be continually updated. The default for this setting is checked.</td>
</tr>
<tr>
<td>Record only queries that run successfully</td>
<td>This option tells Teradata SQL Assistant to record only successful queries into the History pane. The default for this setting is unchecked.</td>
</tr>
<tr>
<td>Do not save duplicate queries in history</td>
<td>This option tells Teradata SQL Assistant not to save duplicate queries in the History pane. The default for this setting is unchecked.</td>
</tr>
</tbody>
</table>
Chapter 1: Getting Started
Overview of the SQL Assistant Interface

Table 2: Description of the Option Dialog (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shade alternate rows in the history table</td>
<td>This option shades alternate rows in the History pane for easier reading.</td>
</tr>
<tr>
<td></td>
<td>The default for this setting is checked.</td>
</tr>
<tr>
<td>Show delete confirmation dialog</td>
<td>This option displays a confirmation dialog when information is deleted.</td>
</tr>
<tr>
<td></td>
<td>The default for this setting is checked.</td>
</tr>
<tr>
<td>Maximum number of history rows to display</td>
<td>Use this option to indicate the maximum number of row displayed in the History pane.</td>
</tr>
<tr>
<td></td>
<td>The default for this setting is 200.</td>
</tr>
</tbody>
</table>

Figure 2: The Options Dialog Box

Query Pane

Use the Query pane to enter and execute a query, automatically run or load a query from a file, or save a query to a file.

```sql
EXPLAIN set_v_employee
SHOW SELECT * FROM MyJoinView;
SELECT Name, Loc
FROM employee, Department
WHERE employee.DeptNo = Department.DeptNo
AND employee.DeptNo IN
  ( SELECT DeptNo FROM Department
    WHERE MgrNo = 10007 ) ;
```
History Pane

Use the History pane to view a table of your past queries and their related processing attributes. You can clear (delete) the information in this pane or save the information to a file.

<table>
<thead>
<tr>
<th>Run Date and Time</th>
<th>Source</th>
<th>Elapsed</th>
<th>Rows</th>
<th>Error</th>
<th>Notes</th>
<th>SQL Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/14/2006 2:07:32 PM</td>
<td>apple</td>
<td>0:00:04</td>
<td>0</td>
<td>3807</td>
<td></td>
<td>set * from AccessRights</td>
</tr>
<tr>
<td>3/13/2006 4:05:16 PM</td>
<td>gnharm</td>
<td>0:00:02</td>
<td>36</td>
<td></td>
<td></td>
<td>set * from employee,</td>
</tr>
<tr>
<td>3/13/2006 3:46:12 PM</td>
<td>sawak</td>
<td>0:00:02</td>
<td>248</td>
<td></td>
<td></td>
<td>set * from tdwn configuratin</td>
</tr>
</tbody>
</table>

For more information about the History pane, see “About the History Pane” on page 31 and “Using the History Pane” on page 32.

AnswerSet Pane

You use the AnswerSet pane to view a table with the results from your query. You can save the information to a file.

<table>
<thead>
<tr>
<th>DatabaseName</th>
<th>DatabaseId</th>
<th>OwnerId</th>
<th>PasswordString</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTEMDFE</td>
<td>0000EB03</td>
<td>00000100</td>
<td>yRd4-0qoE</td>
</tr>
<tr>
<td>EXTRUSER</td>
<td>0000C500</td>
<td>00000500</td>
<td>yQ2pQ</td>
</tr>
<tr>
<td>CRASHDUMPS</td>
<td>0000ED03</td>
<td>00000100</td>
<td>¥Á*™í±ç&amp;µ@!¥606/02/02 20:21:16</td>
</tr>
<tr>
<td>CONSOLE</td>
<td>0000F003</td>
<td>00000100</td>
<td>?</td>
</tr>
<tr>
<td>TDFUSER</td>
<td>0000E903</td>
<td>00000100</td>
<td>¥Á*™í±ç&amp;µ@!¥606/02/02 20:10:41</td>
</tr>
<tr>
<td>SYSUDTLIB</td>
<td>0000E003</td>
<td>00000100</td>
<td>?</td>
</tr>
<tr>
<td>SYS_CALENDAR</td>
<td>0000E003</td>
<td>00000100</td>
<td>¥RÖ8ÝÜkJ</td>
</tr>
</tbody>
</table>

For more information about the AnswerSet pane, see “About the AnswerSet Pane” on page 27 and “How to Use the AnswerSet Pane” on page 27.

Database Explorer Tree

Use the Database Explorer Tree to view databases and objects.

Click the plus sign next to a database name or folder to expand the tree and view the objects. The Database Explorer Tree is an optional feature that you can show or hide.
Chapter 1: Getting Started
Overview of the SQL Assistant Interface

For more information about using the Database Explorer Tree, see “About the Database Explorer Tree” on page 39 and “Using the Database Explorer Tree” on page 40.

Status Bar

The status bar appears across the bottom of the browser and displays status information on your query. In the example below, the status bar shows an error message because the information requested in the query does not exist in the database.

In Microsoft Internet Explorer, after a query has executed successfully, the status bar shows, “Complete, x Rows Processed,” when the query is complete. Also, the status bar gives you database messages such as error code numbers and brief information to assist you in diagnosing an error. For more information on error codes, see Appendix A: “Troubleshooting.”

If you want to hide the status bar, from the View menu, uncheck Status Bar.

Changing the Database Password

You can change the password for the database by clicking the password icon on the tool bar. Clicking the icon opens a dialog. You must enter the old password, then the new password, then confirm the new password.

Note: If your original password was entered automatically, you can not change the password and the password change icon will be inactive.
Using the Explain Query Feature

The Query Explain icon shows the steps a query takes to complete. The steps appear in the AnswerSet pane. The explanation includes estimated times, number of rows (if applicable) and the various resources in the database affected by the query.

Figure 3 shows an example of an explanation of the following query:

select * from dbc.accounts

Figure 3: Example of a Query Explanation

<table>
<thead>
<tr>
<th>DatabaseName</th>
<th>DatabaseId</th>
<th>OwnerId</th>
<th>PasswordString</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTEMFE</td>
<td>0000EB03</td>
<td>00000100</td>
<td>y=51-06/02/02 20:10:56</td>
</tr>
<tr>
<td>EXTUSER</td>
<td>00005F00</td>
<td>00000500</td>
<td>y=51-02/02 20:16:26</td>
</tr>
<tr>
<td>CRASHDUMPS</td>
<td>0000ED03</td>
<td>00000100</td>
<td>y=51-06/02/02 20:21:16</td>
</tr>
<tr>
<td>CONSOLE</td>
<td>0000F003</td>
<td>00000100</td>
<td>y=51-06/02/02 20:10:41</td>
</tr>
<tr>
<td>TDFUSER</td>
<td>00009003</td>
<td>00000100</td>
<td>y=51-06/02/02 20:21:35</td>
</tr>
<tr>
<td>SYSU DTLIB</td>
<td>0000EF03</td>
<td>00000100</td>
<td>y=51-06/02/02 20:21:35</td>
</tr>
</tbody>
</table>

Use the Query Explain feature to view the impact a query may have on database resources. The example above is an explanation of a simple query. Longer, more complex queries will require more database resources. The Query Explain dialog shows what the resource impact may be.

Shortcut Menus

You can use a shortcut menu to access routine functions. Right-click the mouse button on any area in the browser or press Shift-F10 to open a shortcut menu containing commands appropriate for that area.

Query Text Box Shortcut Menu

You can use a shortcut menu to access routine functions in the Query text box. Right-click on the mouse button on any area within the Query text box or press Shift-F10 to display a shortcut menu containing commands.

Figure 4: Query Text Box Shortcut Menu
Table 3: Query Text Box Shortcut Menu Commands and Descriptions

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undoes or reverses the last action you took.</td>
</tr>
<tr>
<td>Cut</td>
<td>Cuts the selected text from the Query text box and saves it to the Clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected text from the currently active window to the Clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the contents of the Clipboard in your query at the current insertion point. If you have text selected in the Query text box, that text is replaced by the text from the Clipboard.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes any portion of the query that is highlighted.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the text in the Query text box. The text is highlighted and future actions apply to the entire query as a whole. The primary use of this function allows you to copy the query to the Clipboard.</td>
</tr>
</tbody>
</table>

**Warning:** Anything you type at this point replaces your entire query.

Clipboard Support for the Query Text Box

The purpose of clipboard support is to quickly access routine functions when you are using the Query text box.

In the Query text box, you can highlight with the mouse, double-click a word, repositioning the cursor, cut, copy, and paste.

The following commands are available using shortcut keys:

Table 4: Microsoft Internet Explorer Commands and Shortcut Keys

<table>
<thead>
<tr>
<th>Command</th>
<th>From the Edit Menu</th>
<th>Shortcut Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Click Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Click Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Click Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Select All</td>
<td>Click Select All</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Find</td>
<td>Click Find (on This Page)</td>
<td>Ctrl+F</td>
</tr>
</tbody>
</table>

Setting Browser Window Font Size

You can maximize the information you see on your screen by adjusting the font size in the browser window. This may be particularly useful when you are viewing information in the History and AnswerSet panes.

For Microsoft Internet Explorer, from the View menu, choose Text Size. Choose a smaller font size so you can see more information. In Netscape 7 or later, click the View menu and select Text Zoom, to change the font size.
The font size change applies to the current browser window and all browser windows you open in the future.

## Printing

You can print the contents of the individual Query, History, and AnswerSet panes by clicking the print icon on each pane. For information, see the following links:

- [Printing a Query](#)
- [Printing the Answer Set Table](#)
- [Printing the History Table](#)
CHAPTER 2 Using the Query Pane

In this chapter, you will become familiar with the features and functions of the Query pane. This chapter contains the following information:

- About the Query Pane
- How to Use the Query Pane
- Using Query Builder
- Printing a Query

About the Query Pane

In the Query pane, use the Query text box to enter and execute a query, automatically run or load a query from a file, or save a query.

Queries can have one or more statements, and can return zero or more AnswerSets. You can enter SQL, Data Definition Language (DDL), or Data Manipulation Language (DML) statements in the Query text box.

The following is an example of what the Query pane looks like, including an example query within the Query text box:

```
EXPLAIN select * employee  
show select * from MyJoinView; 
select Name, Loc 
from employee, Department 
where employee.DeptNo = Department.DeptNo 
and employee.DeptNo in 
  ( select DeptNo from Department 
  where MgrNo = 10007 );
```

Before You Begin

The SQL, DDL, and DML statements you create must conform to the syntax defined by the ODBC data source you are connected to.

You can create queries consisting of one or more statements. Each statement in the query is submitted separately to the RDBMS, therefore, your query can return more than one AnswerSet.
You cannot send the same query to multiple databases. A query can be sent to only one database at a time.

**Important:** To maintain security and to help maximize your server’s resources, your browser’s connection expires after 30 minutes of inactivity. If this occurs, you need to connect to the data source again. See “To Connect to a Teradata Database” on page 6.

### Aborting Queries

You can abort or cancel a query using SQL Assistant or Teradata Manager.

**Aborting Queries Using SQL Assistant**

For more information, see “Aborting a Query in Progress” on page 22.

**Aborting Queries Using Teradata Manager**

A query running on the RDBMS is the same, jobwise, no matter where it originates. As long as it is running on the database, it can be viewed and aborted by Teradata Manager.

Use the Session Information or the Teradata Performance Monitor applications. With the Idle Report in Session Information, you can even set thresholds so that queries are automatically aborted after they have been idle for more than the specified limit. For information, see the *Teradata Manager User Guide*.

### How to Use the Query Pane

#### Entering and Executing a Query

**To Enter and Execute a Query**

After you establish a connection to a data source, you are ready to enter and execute a query.

**Important:** For your multi-statement queries to execute, insert a semicolon after each statement.

1. Click in the **Query** text box and type your statement, or see “Copying Queries from History Pane to the Query Pane” on page 33.

2. Click the execute icon to execute a query.
   
   After you click the execute icon, SQL Assistant submits the query in the Query text box to the database. Each statement in the query is submitted separately to the database.

3. From the **AnswerSet** pane, view the results from your query. The results appear in one or more AnswerSets.
   
   For more information about the AnswerSet pane, see Chapter 3: “Using the AnswerSet Pane.”
Chapter 2: Using the Query Pane

How to Use the Query Pane

4 Glance at the History pane. Your executed statement appears as the first row in the History pane.

For more information about the History pane, see Chapter 4: “Using the History Pane.”

Saving a Query

You can save a query so you can refer to it again at a later time. The following steps explain how.

Note: The following steps may differ depending on the browser version you are using.

To Save a Query

1 Click the Save icon in the Query pane.
2 In the Save Format dialog box, select one of the following:
   • SQL File (*.sql, opens in the application associated with the .sql extension.)
   • Definition (*.ddl, opens in the application associated with the .ddl extension.)
   • Text File (*.txt, opens in Notepad)
   • Unicode Text (*.txt, opens in Notepad)
3 A File Download dialog opens. Select either Open or Save. If you select Open, the file opens in the application associated with the file extension.
4 If you click Save, enter a file name and location, then click Save.

Automatically Running a Query from a File

You can automatically run a query from a file. The following steps explain how.

To Automatically Run a Query from a File

1 Click the Open Query icon on the toolbar.
2 In the text box located above the Run button, enter the fully qualified name of a text file containing the query you want to run.
   Or, to locate an existing text file, click Browse located to the right of the text box. From the Choose file dialog box, locate the text file and click Open.
3 Click Run.
The query is processed and a copy of the query appears in the Query text box at the same
time as your AnswerSet appears in the AnswerSet table. The SQL statement stored in the
History table is the query that was executed.

**Loading a Query from a File Without Running It**

Sometimes you may need to modify a query you saved to a file before you run it.

---

**To Load a Query from a File**

1. Click the **Open Query** icon on the toolbar.
2. In the text box located above the **Load** button, enter a fully qualified name of a text file
   containing a query you wish to load.
   Or click **Browse** located to the right of the text box to find the file. From the **Choose file**
dialog box, locate the text file and click **Open**.
3. Click **Load**.
   The query loads into the **Query** text box so you can make changes.
4. Modify the query as desired.
5. Click **Execute** to execute the query.

---

**Aborting a Query in Progress**

When you submit a query, you have the option to abort it in progress. You may want to abort
a query in progress if it is taking longer to process than you thought or if you change your
mind.

---

**To Abort a Query in Progress**

✔ To abort a query in progress, click **Abort** icon on the Toolbar.

---

**Executing a Query for Large Objects (LOBs)**

SQL Assistant supports LOB (large object) queries. Types of LOBs include CLOBs (character
large object), which are character-based objects, and BLOBs (binary large object), which are
binary objects like pictures or graphics.

When you execute a query for LOB data (either CLOB or BLOB), SQL Assistant prompts you
with the **LOB Dialog** box, shown in Figure 5. Use this dialog to change the name of the object
or the extension. There is also a check box if you want to display the object in the AnswerSet
(appears for BLOBs only).
Figure 5: LOB Dialog Box

The LOB Dialog box is described in the following table.

Table 5: LOB Dialog Box Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Name</td>
<td>Shows the name of the database column where the object is stored.</td>
</tr>
<tr>
<td>File Name</td>
<td>Indicates the file name. The default is the Column Name. You can change the file name if you want.</td>
</tr>
<tr>
<td>FileType</td>
<td>Shows the file type of the object. You can change the file extension if you want. For example, if your query finds a BLOB, its extension will be .dat. You can change the extension in the LOB Dialog box to .bmp or .jpeg so the application you are using knows how to display the BLOB.</td>
</tr>
<tr>
<td>Display as picture in answerset</td>
<td>To display the BLOB object (usually a picture or graphic) in the AnswerSet, click Display as picture in answerset check box. This check box does not appear when CLOB objects are queried.</td>
</tr>
</tbody>
</table>

Select OK when finished with the dialog box. SQL Assistant opens a LOB Dialog for each LOB object in the query. Fill in each dialog as necessary.

When the query is complete, the AnswerSet appears in the AnswerSet window. Figure 6 on page 24 shows the AnswerSet window with a BLOB answer.

If the Display as picture in answerset check box is marked the object appears in the AnswerSet. If the check box was not marked, a button is displayed in the AnswerSet with the BLOB file name. Click the button and a secondary window opens showing the object. The following figure shows an AnswerSet with both the objects displayed and the object buttons.
Saving Large Objects

Large objects can be saved clicking the save icon in the AnswerSet pane. All LOBs are automatically saved as .zip files.

Printing a Query

You can print a query using the following procedure.

To print a query

✔ Click the printer icon on the Query tab to print the query. A print preview window opens. Select File and Print.

The following is an example of the Query print window.

Figure 7: Query Print Preview Window

Using Query Builder

Query Builder is an SQL library tool used to show and build query statements. Query Builder is displayed in a floating window that opens when you are working in the Query pane.

To open Query Builder, click the SQL icon on the toolbar.
The Query Builder window has two panes. The pane on the left side shows the possible SQL commands. The right side is where the sample query is displayed. Figure 8 shows the Query Builder window.

Figure 8: Query Builder Window

![Query Builder Window]

Building a Query

Use the Query Builder to construct simple or complex queries.

From the drop-down list in the upper left corner, choose either SQL Statement or Procedure Builder.

Click the command in the left pane to automatically copy the statement into the Query window.

The following table explains each option.

Table 6: Query Builder Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| SQL Statements     | When you choose the SQL Statements option, the statement list in the left pane shows each of the statement types available on the current data source.  
**Note:** The Teradata syntax file includes new syntax to support Teradata V2R6.  
Select a command from the statement list in the left pane to display an example of its syntax in the right pane. |
| Procedure Builder  | When you choose the Procedure Builder option, the left pane shows a list of statements that are valid only when used in a Teradata CREATE or REPLACE procedure statement.  
Select a stored procedure statement from the list in the left pane to display an example of its syntax in the right pane. |
Inserting a Statement or Procedure into the Query Window

To Insert a Statement or Procedure into the Teradata SQL Query pane, click either the Insert link or the Replace link in the Query Builder window. **Insert** link places the statement after any existing statement in the Query pane. **Replace** deletes any statements in the Query pane and adds the statement from Query Builder.
CHAPTER 3 Using the AnswerSet Pane

In this chapter, you will become familiar with the features and functions of the AnswerSet pane. This chapter contains the following information:

- About the AnswerSet Pane
- How to Use the AnswerSet Pane

About the AnswerSet Pane

In the AnswerSet pane, you can see the AnswerSet table that shows the results from your query. If a query returns multiple AnswerSets, each appears in its own AnswerSet table.

In addition, you can save an AnswerSet to a file. This enables you to analyze the data in Microsoft Excel. To learn how to save an AnswerSet to a file, see "Saving an AnswerSet to a File" on page 28.

The AnswerSet pane is easy to navigate, and you can sort and print the AnswerSet. For more information, see "Printing" on page 18.

The following is an example of the AnswerSet pane. This is displaying one of three AnswerSet tables:

<table>
<thead>
<tr>
<th>DatabaseName</th>
<th>DatabaseId</th>
<th>OwnerId</th>
<th>PasswordString</th>
<th>ProtectionType</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSTEMFE</td>
<td>0000EB03</td>
<td>000000100</td>
<td>98S-%\E\Ep06/02/02 20:10:56</td>
<td>F</td>
</tr>
<tr>
<td>EXTUSER</td>
<td>00000500</td>
<td>000000500</td>
<td>9cE1cO2pQ06/02/02 19:58:26</td>
<td>N</td>
</tr>
<tr>
<td>CRASHDUMPS</td>
<td>0000ED03</td>
<td>000000100</td>
<td>9A*\E\Ep06/02/02 20:21:16</td>
<td>F</td>
</tr>
<tr>
<td>CONSOLE</td>
<td>0000F003</td>
<td>000000100</td>
<td>?</td>
<td>N</td>
</tr>
<tr>
<td>TDFUSER</td>
<td>0000E903</td>
<td>000000100</td>
<td>9e\E\Ep06/02/02 20:10:41</td>
<td>N</td>
</tr>
<tr>
<td>SYSUDTLIB</td>
<td>0000EF03</td>
<td>000000100</td>
<td>?</td>
<td>N</td>
</tr>
<tr>
<td>SYS CALENDAR</td>
<td>0000EB03</td>
<td>000000100</td>
<td>9fRO\E\Ep06/02/02 20:21:35</td>
<td>F</td>
</tr>
</tbody>
</table>

How to Use the AnswerSet Pane

**Viewing Your Results**

When you run a query the results appear in the AnswerSet pane.
Queries that return larger results may return more than one page of results. To view additional pages, click the number 2 in the lower left hand corner of the AnswerSet pane. Click higher numbers to view additional results.

When you submit multiple statements from the Query pane to the RDBMS, you can view the results of each statement by clicking the tabs: AnswerSet 2, AnswerSet 3, etc. The results returned are in the order they were submitted. For example, AnswerSet 2 is the second statement you submitted.

The AnswerSet tab is black for the AnswerSet you are currently viewing. The remaining AnswerSets that are grayed out can be viewed by clicking the corresponding AnswerSet tab.

### Sorting an AnswerSet

To Sort an AnswerSet

✔ Click any column heading to sort by the data in that column.

The data is initially sorted in ascending order. Clicking the same column heading again sorts the data in descending order.

**Note:** BLOBs and CLOBs can not be sorted.

### Reordering Columns in an AnswerSet

To Reorder Columns in an AnswerSet

✔ Click on any column heading, then drag and drop it to the desired location in the AnswerSet.

### Saving an AnswerSet to a File

To save an AnswerSet and the column headings to a file, use the following procedure.

To Save an AnswerSet to File

1. Click the **Save** icon on the AnswerSet pane.
2. From the **Save Format** dialog box, select one of the follow:
   - Tab delimited (*.txt, opens in Notepad)
3 The **File Download** opens. Select **Save** or **Open**. If you select **Open**, the extension determines which application the file saves as.

4 If you click **Save**, enter the file name and location, then click **Save**.

### Opening a Saved Answerset with Microsoft Excel

You may want to open a saved answerset in Excel. The following steps explain how.

1. Open Excel.
2. From the **File** menu, choose **Open**.
3. In the **Open** dialog box, from **Files of type** list, choose **All Files**.
4. Highlight the `.txt` file you saved when you completed the procedure listed above, and click **Open**.
5. In the **Text Import Wizard** dialog box, choose **Delimited**, and click **Next**.
6. Make sure the delimiters **Tab** checkbox is selected, and click **Next**.
7. Make sure the **Column data format** is General, and click **Finish**.

### Copying an AnswerSet to the Clipboard

1. Highlight the columns or rows in the AnswerSet you want to copy.
2. From the **Edit** menu, click **Copy**. The contents of the highlighted cells are copied to the Clipboard.

### Printing the Answer Set Table

You can print an Answer set using the following procedure.

1. Print the Answer Set table by clicking the print icon on the Answer Set tab. The following window opens. Select **File**, then click **Print**.

   The following is an example of the Answer set window ready to print.
### Figure 9: Answer Set Print Preview Window

<table>
<thead>
<tr>
<th>UserID</th>
<th>DatabaseID</th>
<th>TVMID</th>
<th>FieldId/AccessRightWithGrant</th>
<th>GrantorID</th>
<th>AllInFlag</th>
<th>CreateUserID</th>
<th>CreateTimeStamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000E00</td>
<td>0000E00</td>
<td>00000000000000</td>
<td>N</td>
<td>000000100</td>
<td>M</td>
<td>000000100</td>
<td>22/02/06 10:53:32 PM</td>
</tr>
<tr>
<td>0000E00</td>
<td>0000E00</td>
<td>00000000000000</td>
<td>N</td>
<td>000000100</td>
<td>M</td>
<td>000000100</td>
<td>22/02/06 10:53:32 PM</td>
</tr>
<tr>
<td>0000E00</td>
<td>0000E00</td>
<td>00000000000000</td>
<td>N</td>
<td>000000100</td>
<td>M</td>
<td>000000100</td>
<td>22/02/06 10:53:32 PM</td>
</tr>
<tr>
<td>0000E00</td>
<td>0000E00</td>
<td>00000000000000</td>
<td>N</td>
<td>000000100</td>
<td>M</td>
<td>000000100</td>
<td>22/02/06 10:53:32 PM</td>
</tr>
<tr>
<td>0000E00</td>
<td>0000E00</td>
<td>00000000000000</td>
<td>N</td>
<td>000000100</td>
<td>M</td>
<td>000000100</td>
<td>22/02/06 10:53:32 PM</td>
</tr>
</tbody>
</table>

- **UserID**: Identifies the user associated with the row.
- **DatabaseID**: Identifies the database associated with the row.
- **TVMID**: Identifies the table or view associated with the row.
- **FieldId/AccessRightWithGrant**: Identifies the field or access right associated with the row.
- **GrantorID**: Identifies the grantor associated with the row.
- **AllInFlag**: Indicates whether all items are included.
- **CreateUserID**: Identifies the user who created the row.
- **CreateTimeStamp**: Indicates the time and date the row was created.
CHAPTER 4 Using the History Pane

In this chapter, you will become familiar with the features and functions of the History pane. This chapter contains the following information:

- About the History Pane
- History Pane Control Items
- Using the History Pane
- Using the Edit History Dialog

About the History Pane

In the History pane, you can see the History table that shows your past queries and their related processing attributes. The most recently executed statement appears as the first row in the History table.

If you log into Teradata with a different user name in the future, your History pane will not contain a table until you send queries to the database.

In addition, you can:

- Delete individual queries.
- Sort the information in the History table.
- Clear (delete) the information from this table.
- Save the information to a file.
- Add notes to any row in the History table.
- Replace the current contents in the Query text box with the query contained in the SQL Statement column in the History table.
- Edit Individual Queries.

The following is the History pane displaying a sample History table:

<table>
<thead>
<tr>
<th>Run Date and Time</th>
<th>Source</th>
<th>Elapsed</th>
<th>Rows</th>
<th>Error</th>
<th>Notes</th>
<th>SQL Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit 3/14/2006 2:07:32 PM</strong></td>
<td>apple</td>
<td>00:00:04</td>
<td>0</td>
<td>3807</td>
<td></td>
<td><code>select * from AccessRights</code></td>
</tr>
<tr>
<td><strong>Edit 3/13/2006 4:05:16 PM</strong></td>
<td>gingham</td>
<td>00:00:02</td>
<td>36</td>
<td></td>
<td></td>
<td><code>select * from employee</code></td>
</tr>
<tr>
<td><strong>Edit 3/13/2006 3:46:12 PM</strong></td>
<td>savak</td>
<td>00:00:02</td>
<td>248</td>
<td></td>
<td></td>
<td><code>select * from tdwm_configurations</code></td>
</tr>
</tbody>
</table>
History Pane Control Items

The function of History pane items are described in the following table.

Table 7: History Pane Column Descriptions

<table>
<thead>
<tr>
<th>Table Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>None link</td>
</tr>
<tr>
<td>Clear checkbox</td>
<td>Check this box and press the Clear History link to delete at row. Caution: There is no undo for this feature.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit History dialog. Use this dialog to add notes, make changes to the SQL statement, read the complete text of errors. See “Using the Edit History Dialog” on page 35 for more information about the Edit History dialog.</td>
</tr>
<tr>
<td>RunDate/EndTime</td>
<td>Shows the date the query executed and the time the query ended.</td>
</tr>
<tr>
<td>Source</td>
<td>Indicates the name of the ODBC data source SQL Assistant is connected to when the query was executed.</td>
</tr>
<tr>
<td>Elapsed</td>
<td>Shows the total elapsed time to run a query.</td>
</tr>
<tr>
<td>Rows</td>
<td>Indicates the number of rows matching the query submitted.</td>
</tr>
<tr>
<td>Error</td>
<td>Indicates the numerical code for any error message.</td>
</tr>
<tr>
<td>Notes</td>
<td>Shows notes or comments the user attached to the query.</td>
</tr>
<tr>
<td>SQL Statement</td>
<td>Shows the SQL statement that was submitted to the database.</td>
</tr>
<tr>
<td>User ID</td>
<td>Shows the User ID who submitted the query.</td>
</tr>
<tr>
<td>Fetch Time</td>
<td>Shows the time taken to return the data.</td>
</tr>
</tbody>
</table>

Note: Multi-statement queries show the total number of rows returned for all queries.
For information on error codes and resolution, see “Viewing Error Code Information” on page 35.

Using the History Pane

The following information will help you become familiar with using the History pane.

Viewing Additional History Tables

The History table can contain multiple tables. The numbered links at the bottom of the table allow you to view different tables.
To View Addition History Tables

✔ To view different history tables, click the numbers in the lower left corner of the History pane.

Click higher numbers to view older history tables.

Copying Queries from History Pane to the Query Pane

To save time retyping the text of a query, you can copy previous queries from the History pane to the Query pane.

To Copy Queries from the History Pane

✔ Click the SQL statement you want to copy under the SQL Statement column in the History pane. It appears as a link under the SQL Statement column.

The SQL statement from the History table displays in the Query text box.

Sorting History

To Sort the History Table

✔ Click any column header again to sort the data in descending column.

Adding Notes

To Add Notes in the History Pane

1 In the History table, click Edit link for the corresponding row. The Edit History dialog box opens.
2 Enter the desired information in the Your Notes box.
3 Click Update to add your notes to the History table,
   Or click Cancel to erase the information and return to the browser window.

The added note appears in the History pane under the Notes column. To learn more about the Edit history dialog, see “Using the Edit History Dialog Box” on page 36.

Saving History Rows

You may want to save the columns in the History pane for later reference. The following steps explain how.

Note: You cannot reload a saved history file into a new History pane.
Chapter 4: Using the History Pane

Using the History Pane

**To Save History to a File**

1. Click **Save** icon on the History pane.
2. In the **Save Format** dialog box, select one of the following:
   - SQL File (*.sql, opens in the application associated with the .sql extension.)
   - Definition (* .ddl, opens in the application associated with the .ddl extension.)
   - Text File (*.txt, opens in Notepad)
   - Unicode Text (*.txt, opens in Notepad)
3. A **File Download** dialog opens. Select either **Open** or **Save**. If you select **Open**, the file opens in the application associated with the file extension.
4. If you click **Save**, enter a file name and location, then click **Save**.

**Copying Rows to the Clipboard**

**To Copy Rows from the History Pane to the Clipboard**

1. Highlight the columns or rows in the AnswerSet you wish to copy.
2. Right-click and select **Copy**. The contents of the highlighted cells are copied to the Clipboard.

**Clearing History Rows**

**Warning:** This action cannot be undone.

To clear (delete) specific rows in the History table, checkmark the row using the checkbox in the first column, then click the clear history icon on the History Pane. The selected rows will be cleared.

To delete all the rows in the History table, click the **All** link on the history tab, then click the clear history icon. This action deletes the entire history table. There is no undo.

Click the **None** link to uncheck rows in the History table.

**Printing the History Table**

You can print the history table using the following procedure.

**To print the History Table**

✔ Click the printer icon on the History tab to print the query. A print preview window opens. Select **File** and **Print**.

The following is an example of the print window.
Viewing Error Code Information

The History table displays an error code when an error occurs. To view the entire error message open the Edit History dialog by clicking **Edit** for the corresponding row in the History table.

For information on error codes and resolution, refer to Appendix A: “Troubleshooting” or refer to **Messages**. See ”Additional Information” on page v.

Using the Edit History Dialog

The Edit History dialog box allows you to view information about a specific query in the History pane. You can use the Edit History dialog box to do the following:

- Edit the text of an error message and other messages
- Add to notes to the specific SQL statement
- Updates an SQL statement

To open the Edit History dialog, click the **Edit** link on the row in the History pane containing the query you want to view.

**Figure 11** shows an example of the Edit History dialog box.
Figure 11: Edit History Dialog Box

Using the Edit History Dialog Box

- The top pane shows the SQL statement. The left side shows a list of information about the query.
- Add notes in the Your Notes field.
- The Result Message field shows the message generated when the SQL statement was submitted. This field also shows the complete error message if an error occurs.
- Use the controls on the bottom of the dialog to delete and update the dialog information.

Table 8 explains the fields in the History dialog box. You can not edit these fields. They are informational only.

Table 8: Edit History Dialog Field Descriptions

<table>
<thead>
<tr>
<th>Edit History Dialog Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Date</td>
<td>Shows the date the query executed and the time the query ended.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Shows the run time of a query.</td>
</tr>
<tr>
<td>Elapsed</td>
<td>Shows the total elapsed time to run a query.</td>
</tr>
<tr>
<td>Database Time</td>
<td>Shows the amount of time the query ran on the database.</td>
</tr>
<tr>
<td>Fetch Time</td>
<td>Shows the time taken to return the data.</td>
</tr>
<tr>
<td>Rows</td>
<td>Indicates the number of rows matching the query submitted.</td>
</tr>
</tbody>
</table>
Table 8: Edit History Dialog Field Descriptions (continued)

<table>
<thead>
<tr>
<th>Edit History Dialog Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Indicates the name of the ODBC data source SQL Assistant is connected to when the query was executed.</td>
</tr>
<tr>
<td>User ID</td>
<td>Shows the User ID who submitted the query.</td>
</tr>
</tbody>
</table>
Chapter 4: Using the History Pane
Using the History Pane
CHAPTER 5 Using the Database Explorer Tree

In this chapter, you will become familiar with the features and functions of the Database Explorer Tree. This chapter contains the following information:

- About the Database Explorer Tree
- Using the Database Explorer Tree

About the Database Explorer Tree

The Database Explorer Tree lists databases and objects in the Teradata Database server to which you are connected.

You can use the Database Explorer Tree to:

- View the hierarchy so you can see the objects when you create or delete them.
- Find table and column names, as well as object names.

When you start SQL Assistant, the following databases appear in the Database Explorer Tree: dbc, the database associated with the username used to connect to the Teradata Database server, and your default database (if it is different from username).

The databases do not have to be visible in the Database Explorer Tree in order for you to send queries. You can send queries to any database as long as your DBA has set access permissions.

The Database Explorer Tree appears on the left side of your browser.

You can click the plus sign next to a database name to see folders for tables, views, macros, functions, and procedures associated with that database.
Using the Database Explorer Tree

The following information helps you become familiar with using the Database Explorer Tree.

Showing or Hiding the Database Explorer Tree

The Database Explorer Tree automatically appears when you start SQL Assistant.

To display or hide the Database Explorer Tree, click the Database Tree icon on the toolbar.

For more information, see “Resizing the Database Explorer Tree Area” on page 40.

Resizing the Database Explorer Tree Area

To resize the width of the Database Explorer Tree area, click the right edge of the Explorer Tree frame. The mouse pointer becomes a double arrow. Drag the arrow horizontally to change the size of the display.

Viewing Object Types

Expanding the Branches

To expand the tree to show all of the objects, click the plus sign (+) next to the database name or folder.

Expanding the folder loads only those object types. If no objects exist for a given object type, the folder remains but no objects appear below the folder and the plus sign disappears to give you a visual cue that no objects are in the folder.

Collapsing the Branches

To collapse the tree to hide all of the objects, click the minus (-) sign next to the database name or folder.

Object Types in the Database Explorer Tree

When you create a new object, it will not appear in the Database Explorer Tree until you open the parent folder. If the parent folder is already open or has been opened during your current session, the new object does not appear until after you disconnect and reconnect to the database. The same holds true when you remove an object.
Using the Database Explorer Tree

To Add a Database to the Database Explorer Tree

1. From the Database Explorer Tree, click **Add**.
2. Enter the database name in **Database Name** text box.
3. Click **OK**.

The database you added is displayed in the Database Explorer Tree.

**Note:** If you try to add a database that does not exist in the Teradata Database, a message appears explaining the database or user does not exist. The database will not be added to the Database Explorer Tree.

To Remove a Database from the Database Explorer Tree

1. From the Database Explorer Tree, click **Remove**.
2. Enter the database name in **Database Name** text box.
3. Click **OK**.

The database you removed is no longer displayed in the Database Explorer Tree.

If you inadvertently remove a database, you can add it again.

**Note:** You cannot remove your default database from the Database Explorer Tree.

---

<table>
<thead>
<tr>
<th>If you add a…</th>
<th>then the following are added…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td><strong>Columns</strong> and <strong>Indexes</strong></td>
</tr>
<tr>
<td>View</td>
<td><strong>Columns</strong></td>
</tr>
<tr>
<td>Macro Function</td>
<td><strong>Parameters</strong></td>
</tr>
<tr>
<td>Procedure</td>
<td></td>
</tr>
</tbody>
</table>
APPENDIX A Troubleshooting

This appendix gives you recommended solutions to common errors or messages as well as helpful hints.

- Error Codes in the History Table
- Browser Messages and Errors
- Helpful Hints

Error Codes in the History Table

If you submit a query and receive an error code in the Error column of the History table, review the following list of recommended solutions:

Table 9: Solutions to Error Codes in the History Table

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1811</td>
<td>The server PC may no longer be connected to the data source. Do the following:</td>
</tr>
<tr>
<td></td>
<td>1 Close your browser.</td>
</tr>
<tr>
<td></td>
<td>2 Reopen your browser and log on.</td>
</tr>
<tr>
<td></td>
<td>3 If you are submitting your request from a client PC, ensure the connection from the server PC to the database is still active.</td>
</tr>
<tr>
<td></td>
<td>4 Resubmit your query.</td>
</tr>
<tr>
<td>3707</td>
<td>The SQL statement may contain incorrect syntax. Do the following:</td>
</tr>
<tr>
<td></td>
<td>1 Recheck your SQL statement.</td>
</tr>
<tr>
<td></td>
<td>2 Resubmit your query.</td>
</tr>
<tr>
<td>3802</td>
<td>The database name in the SQL statement does not exist. Do the following:</td>
</tr>
<tr>
<td></td>
<td>1 Recheck your SQL statement.</td>
</tr>
<tr>
<td></td>
<td>2 Resubmit your query.</td>
</tr>
<tr>
<td>3807</td>
<td>The SQL statement may contain a reference to a table or object that does not exist. Do the following:</td>
</tr>
<tr>
<td></td>
<td>1 Recheck the name of the table or object,</td>
</tr>
<tr>
<td></td>
<td>Or, quantify the table name with a database name. For example &lt;database.tablename&gt;.</td>
</tr>
<tr>
<td></td>
<td>2 Resubmit your query.</td>
</tr>
</tbody>
</table>
| **Note:** SQL Assistant does not support the SQL DATABASE command. If you want to change your default database to something other than your username, disconnect and log back in, then enter the desired default database in the Default Database text box.
To avoid errors, check to ensure you have logged into a database that exists and the RDBMS name is valid.

For additional information on error codes and how to resolve problems, refer to Messages, specifically Chapter 6: Messages and Chapter 15: Client UTY. See “Additional Information” on page v.

**Browser Messages and Errors**

If you submit a query and receive a browser message or error, review the list below of recommended solutions.

To avoid errors, check to ensure you have logged into a database that exists and the RDBMS name is valid.

<table>
<thead>
<tr>
<th>Message or Error</th>
<th>Explanation and/or Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Application Unavailable</td>
<td>1. Click the <strong>Refresh</strong> button in the browser toolbar. 2. Click <strong>Retry</strong>. 3. Resubmit your query.</td>
</tr>
<tr>
<td>Server Error in Application: Object reference not set to an instance of an object.</td>
<td>1. Close your browser. 2. Open your browser and connect to the database. 3. Resubmit your query.</td>
</tr>
<tr>
<td>Your session has timed-out due to inactivity.</td>
<td>Your session with the server PC expired due to inactivity from your client PC. This occurs for security reasons and to help maximize server resources. Click the &quot;<strong>Click here to reconnect</strong>&quot; link to reconnect to the server. You will be prompted to choose a server and enter a user name and password.</td>
</tr>
<tr>
<td>Data type mismatch in criteria expression.</td>
<td>If you receive this message, the SQL request you submitted does not appear in the History table. Your current Regional Options setting is restricting your ability to maintain the history of submitted SQL requests. To correct this problem, do the following: 1. From your Microsoft Windows desktop, click <strong>Start</strong>. 2. Go to <strong>Settings</strong>, select <strong>Control Panel</strong>, and select <strong>Regional Options</strong>. The <strong>Regional Options</strong> dialog box opens. 3. From the <strong>Your locale (location)</strong> menu, choose <strong>English (United States)</strong>. 4. Click <strong>OK</strong> to accept the change and close the <strong>Regional Options</strong> dialog box. 5. Resubmit your query.</td>
</tr>
</tbody>
</table>

**Helpful Hints**

The following section contains helpful hints.
**INTERVAL Data Type**

SQL Assistant does not support the INTERVAL data type.

When selecting columns of data type INTERVAL, the following message appears in the AnswerSet instead of the correct data.

Helpful Hint: Resubmit your query without the INTERVAL column.

**TITLE Keyword**

SQL Assistant does not support the TITLE keyword.

**Helpful Hint:**

Instead of entering the following syntax:

```
sel lastname (TITLE 'myname') from employee;
```

Enter the following instead:

```
sel lastname AS myname from employee;
```

This query will generate the expected column headings in the AnswerSet pane.

**Restarting the ASPNet_wp.exe Process**

If you are having trouble loading SQL Assistant, it might be a problem with the aspnet_wp.exe process, which is needed to run SQL Assistant properly.

Restarting this process may solve the problem.

This process only works from the Teradata SQL server, not on the client machine.

---

**To Reset the aspnet_wp.exe**

1. Open the Task Manager (Ctrl+Alt+Del, select **Task Manager**), and select the Processes tab.
2. Highlight the **aspnet_wp.exe** process.
3. Click **End Process**. There will be a series of warnings. Click **Ok**.

Once the aspnet_wp.exe process is ended, Windows automatically restarts it. If this was the problem, you should be able to load SQL Assistant now.
**B**

**BLOB**  An acronym for binary large object. A BLOB is a large database object that can be anything that doesn’t require character set conversion. This includes MIDI, MP3, PDF, graphics and much more. BLOBS can be up to 2 GB in size.

**C**

**CLOB**  An acronym for character large object. A CLOB is a pure character-based large object in a database. It can be a large text file. HTML, RTF or other character-based file. CLOBs can be up 2 GB in size. Also see BLOB and LOB.

column  In the relational model of Teradata SQL, databases consist of one or more tables. In turn, each table consists of fields, organized into one or more columns by zero or more rows. All of the fields of a given column share the same attributes.

**D**

data definition language (DDL) statements  In Teradata SQL, the statements and facilities that manipulate database structures and the Data Dictionary information kept about these structures. These statements include CREATE, DROP, ALTER, and MODIFY.

data manipulation language (DML) statements  In Teradata SQL, the statements and facilities that change the information content of the database. These statements include INSERT, UPDATE, and DELETE.

DBA  Database Administrator

DBC  Database Computer

DDL  Data Definition Language

delimiter  In Teradata SQL, a punctuation mark or other special symbol that separates one clause in a Teradata SQL statement from another or that separates one Teradata SQL statement from another.

DML  Data Manipulation Language

DNS  Data Source Name

**F**

**Function**  User Defined Functions (UDF) are extensions to Teradata SQL. Users can write UDFs to analyze and transform data already stored in their data warehouse in ways that are beyond the functionality of Teradata’s native functions.
H

**HTML**  Hypertext Markup Language

I

**IIS**  Internet Information Services  
**IP**  Internet Protocol

L

**LOB**  An acronym for large object. A large object is a database object that is large in size. LOBs can be up to 2 gigabytes. There are two types of LOBs, CLOBs and BLOBs. CLOBs are character-based objects, BLOBs are binary-based objects.

M

**macro**  A set of Teradata SQL statements stored in the Teradata Database and executed by a single `EXECUTE` statement. Each macro execution is implicitly treated as a transaction.  
**MDAC**  Microsoft Data Access Component

O

**Open Database Connectivity (ODBC)**  Under ODBC, drivers are used to connect applications with databases. The Teradata ODBC driver processes ODBC calls from an application, but passes SQL requests to the Teradata Database for processing.

P

**parameter**  In Teradata SQL, a variable name in a macro for which an argument value is substituted when the macro is executed.  
**procedure**  Short name for Teradata stored procedure. Teradata provides Stored Procedural Language (SPL) to create stored procedures. A stored procedure contains SQL to access data from within Teradata and SPL to control the execution of the SQL.

R

**RDBMS**  Relational Database Management Systems  
**request**  In host software, a message sent from an application program to the Teradata Database.

S

**SDK**  Software Development Kit
**session**  In client software, a logical connection between an application program on a host and the Teradata Database that permits the application program to send one request to and receive one response from the Teradata Database at a time.

**SQL**  Sequential Query Language

**statement**  A request for processing by the Teradata Database that is processed as a single entity and consists of a keyword verb, optional phrases, and operands.

**T**

**table**  In Teradata SQL, a set of one or more columns with zero or more rows with fields of related information. See also database.

**V**

**view**  In Teradata SQL, an alternate way of organizing and presenting information in the Teradata Database. A view, like a table, has rows and columns. However, the rows and columns of a view are not directly stored by the Teradata Database, but are derived from the rows and columns of tables (or other views) whenever the view is referenced.
Index

A
aborting queries 20
Account String field 7
Add button See Database Explorer Tree
adding
databases 41
notes 33
object types 40
AnswerSet pane
overview 27
AnswerSet table
clipboard, copying to 29
column headers 28
finding 9
font, changing 17
saving an answerset 28
sorting 28
viewing results 27

B
BLOBs See large objects
Browse button See Query pane
browser
address bar 10
browser window
closing 8
font size, changing 17
menu bar 9
shortcut menus 16
status bar 15
toolbar 9

C
cancelling
queries 20
Clear History button See History pane
client PCs
database, connecting to 6
SQL Assistant, how they work with 3
troubleshooting 43
clipboard
answer set, copying 29
history rows, copying 34
Query text box shortcut menu 17
CLOBs See large objects

closing
Database Explorer Tree 40
columns
Database Explorer Tree, adding a column 41
defined 47
commands See specific commands
computer name, finding 5
creating SQL statements 19
Copy command
answerset, copying to clipboard 29
history rows, copying to clipboard 34
Query text box 16, 17
copying to clipboard 29, 34
Create New Data Source dialog box 4
creating SQL statements 19
Cut command, Query text box 16, 17

D
data definition language
defined 47
statements 19
data manipulation language
defined 47
statements 19
data source
defining 3
database
connecting 5
disconnecting 8
Database Explorer Tree
Add button 41
branches
collapsing 40
expanding 40
closing 40
databases
adding 41
dbc 39
default 39
removing 41
object types
adding 40
removing 40
viewing 40
opening 40
overview 39
Index

Remove button 41
  resizing 40
dbc database 39
dbc name or address 7
DDL See data definition language
default database 39
Default Database field 7
Delete command, Query text box 16, 17
delimiter, defined 47
DML See data manipulation language
documentation
  installation 3
DSN
  system 4
  user 4

E
Edit menu
  Copy command 17, 29, 34
  Cut command 17
  Find command 9, 17
  Paste command 17
  Select All command 17
Elapsed column, History table 32, 36
Endtime column, History table 32
entering a query 20
error codes
  column in History table 32
  troubleshooting 43
  viewing 35
errors See troubleshooting
Execute button See Query pane
executing a query 20

F
Favorites menu 6
features, SQL Assistant 1
Fetch Time column, History table 32, 36
File menu 8
files, running a query from 21
Find command, Query text box 17
find feature 9
font size, changing 17

H
History pane
  Clear History button 34
  overview 31
  Save History button 34
History table
  clearing history 34
  clipboard, copying to 34
column
  headers, sorting 33
  names and descriptions 32, 36
error codes 32, 35, 43
finding 9
history rows
  saving 34
  viewing 33
navigating 32
notes, adding 33
viewing 33

I
installing
  information 3
Internet Explorer, using
  answer set, saving 28
  browse window, closing 8
  clipboard support 17
  Database Explorer Tree, showing or hiding 40
  finding 9
  font size, setting 17
  history rows, saving 34
  query, saving 21
  Teradata database, connecting to 6
  URL, saving 6
INTERVAL data type 45
IP address, finding 5

L
large objects
  query for large objects 22
Load button See Query pane
LOBs See large objects

M
macros
  Database Explorer Tree, adding macros 41
  defined 48
main window, SQL Assistant 8
menus
  Edit menu 9, 29, 34
  Favorites menu 6
  File menu 8
  Search menu 9
  shortcut menu, Query text box 16
  View menu 15

N
notes
  adding 33
notes column, History table 32

O
object reference not set to an instance of an object 44
object types, viewing 40
ODBC
  connection, setting up a 3
data source administrator 4
data source, defining 4
defined 48
overview
SQL Assistant 1
overviews
  AnswerSet pane 27
  Database Explorer Tree 39
  History pane 31
  Query pane 19

P
parameters
  Database Explorer Tree, adding parameters 41
defined 48
Password field 7
Paste command, Query text box 16, 17
Printing
  answer set table 29
  history table 34
  query window 24
procedures
  Database Explorer Tree, adding a procedure 41
defined 48
product version numbers iii

Q
queries
  aborting 20
  cancelling 20
  Copy command 17
copying 17
entering 20
executing 20
finding 9
loading 22
notes, adding 32
printing 18
running from a file 21
saving 21
Query Builder
  inserting statement or procedure 26
Query pane
  Browse button 21
  Execute button 20
  Load button 22
overview 19
  Run button 21
Save Query button 21
Query text box
  clipboard support 17
commands
  Copy 17
  Cut 17
  Delete 17
  Find 9, 17
  Paste 17
  Select All 17
  Undo 17
commands and descriptions 17
shortcut menu 16

R
RDBMS
  ODBC
    data source, defining 3
driver, installing a 3
submitting queries 20
Refresh button 44
Remove button See Database Explorer Tree
requests, defined 48
rows column, History table 32, 36
Run button See Query pane
Run Date and Time column, History table 32, 36

S
Save History button See History pane
Save Query As command 21
Save Query button See Query pane
saving
  a query 21
  an answerset 28
  history rows 34
Search menu, Find command 9
Select All command 16, 17
Select All command 16, 17
server PC
  application unavailable error 44
  computer name, finding 5
ero error in application 44
  how it works 2
  IP address, finding 5
  troubleshooting 43
sessions
  Database Explorer Tree 40
defined 49
setting up an ODBC connection 3
shortcut menus
  browser window 16
Index

- Query text box 16
- Show Tree check box 40
- software releases
  - supported iii
- sorting
  - answer set 28
  - answerset 28
- Source column, History table 32, 37
- SQL
  - Statement column, History table 32
- SQL Assistant
  - how it works 2
  - key features 1
  - main window 8
  - overview 1
  - starting 5
- statements
  - DDL 19
  - defined 49
  - DML 19
  - multi-statement queries, creating 19
  - SQL 19
  - statements, creating 19
- status bar, browser window 15
- stored procedures
  - creating 25
  - inserting into Query window 26
- syntax
  - using Query Builder 24
- system DSN 4

T
- tables
  - Database Explorer Tree, adding tables 41
  - defined 49
- text size, changing 17
- troubleshooting 43

U
- Undo command, Query text box 16, 17
- user
  - DSN 4
  - ID column, History table 32, 37
  - Username field 7

V
- version numbers iii
- View menu
  - status bar, displaying 15
  - text size, changing 17
- views
  - Database Explorer Tree, adding views 41

virtual directory See connecting to a database